WAacGo

Information on Handling Print Material

Information on Print Material
Note: Individual information on handling print material are representative of other print materials with
identical handling. The graphics in these notes only represent the print material to be named.
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1. Hardware Preparation

1.1 Roller

1.2 Sensor Settings
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1.3 Load the Print Material and Align It

OInsert the print media roll into the external unroller. Follow steps A, B und C of the application instructions.
Important: Unrolling direction to the left!

The print material is fed into the printer in a counter-clockwise direction.

9 Feed the print material through the feed hole on the back of the printer.

9 Adjust the guide to the width of the print material.

Optimum setting: 1 mm + print material width + 1 mm
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2. GoDoctor — Measure the Print Material Dimensions
GoDoctor printer software
Always use the most up-to-date version of the software. Check your existing installation to make sure that it is

up to date, or download the newest version.

The program file GoDoctor.exe can be found in the smartSCRIPT installation directory on your PC / laptop.
C:/Programme(86)/Wago/smartScript/...
Notice: The [Factory Default] button resets the printer to factory settings.

s GoDoctor Utility For GoDEX Printer V1.001 LI SIS
[Port Help
‘ Printer Configuration l e Auto-Calibration l
|
[
TPH Mileage Reflective Sensing Test

TPH Dot Test Transmissive Sensing Test

Cutter Test

Dump Mode (OFF) Factory Default

|
Printer Status ‘
|
|

Clear |

o Reset Printer

Command Mode

|
|
|
|
|

" Connected use WAGO smartPrinter=14370792 BOOT:1.003 F/W: smartPrinter V1.UW7e

Figure 2.1: GoDoctor dialog box
All individual bits of information (this includes network settings) will be deleted!

Press [Reset Printer] o Wait until the bar of the progress indicator in the display has gone through. The
current print media settings are deleted. The end of the process is confirmed after 20 seconds, by a simple
acoustic signal.

Press [Auto-Calibration] e Material will be fed through the printer!

Figure 2.2 shows the info area in the GoDoctor dialog box with the correct information in line 1 and 4 on the
print material after auto-calibration.

Important:

Auto-calibration has failed if the information in the info area deviates from the information shown in
Figure 2.2.

Check the sensors setting and run auto-calibration again.

Contact our support team if doing this does not yield the results shown in the image.

See-Through Sensing Mode

Figure 2.2: The information area shows
results for the print material
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3. WAGO-Printer-Settings - Set Printer Settings

WAGO-Printer-Settings

Always use the most up-to-date version of the software. Check your existing installation to make sure that it is

up to date, or download the newest version.

Start the WAGO-printer-settings.

Change Offsets/Heat Reset Settings
Installed printers:

OV WAGO smartPrinter

Printer-Settings woe

i
Own Labels Options 9»
.
Selected printer: Export or sittings

1o % Reset smantPrinter

5 f FastViewer
river version:
” Autosensing

20 Check for update

Port: Show only Favourites

5 210-805/000-002

Label 156 mm (white) W S Label 156 mm (yeliow) s

5 210-806 5 210-806/000-002

<2 Label 159 mm (white) B 5P Label 156 mm (yellow) e
7 210-807 5 210-807/000-002

S8 Label 20,8 mm (white) o S0 Label 208 mm (yellow) w
5 210-808 5 210-810

S Label9 525 mm B | 59 L 535 mm we

= Typesigns

= MCS labels

. Button labels

. Wire/cable marking
. Heat Shrink Tube |
= Fabric labels ‘

Figure 3.1: WAGO-printer-settings

In the [Installed Printer] 0 window, choose the WAGO smartPRINTER.
Open the [Options] menu Q and deactivate [Autosensing].

Select the directory e

Select the print material 0

The specific printer settings for the article are transferred to the smartPRINTER as soon as you select the print
material.

Press [OK] to confirm the following instructions dialog box (Figure 3.2).

Information

Import successful
d/

OK

Figure 3.2: Instructions dialog box for driver

The smartPRINTER is now properly set up for the print material.
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4. WAGO-smartSCRIPT - Creating Project Files

WAGO-smartSCRIPT
Always use the most up-to-date version of the software. Check your existing installation to make sure that it is

up to date, or download the newest version.

Important: Uninstall the existing WAGO-smartSCRIPT-software before carrying out any new installations.

Start the WAGO-smartSCRIPT to make the following selections using the wizard:
o Press [Forward] to confirm that [You know the item order number of marking material].

If the wizard does not start up, select [New document (WAGO SCRIPT Wizard)] from the [File] menu bar.

Select the print material 9 and the wizard by clicking on [Finish]e.

4 WAGO SMART SCRIPT wizard =5 4 WAGO SMART SCRIPT wizard [ o
_— Select marking material
How do you want to start? 22210708 (ory TP23B/TP343)
Aun 23-210.710 (ony TP298/TP343)
24210732 (ory TP238/TP343)
YYou know the series of the terminal block 25210801

%- 210802 = =
27210803 A
28. 210804 P

© You know the item order number of marking material SN
30- 210-805/000-002 SR

e 31210806 AN
32-210806/000-002 A S
SERMED ‘You know the marking device 33.210807 NN
34- 210807/000-002 NG,
35210808 s n
36- 210610 S
projectfile create from import data 3721081 " g
38- 210811/000002 Y
Descipiion: order numbe
se¥-adhesive polyester label white 1546 3000 pes/roll - 210-805
Width Marking device:
view wizard after each stat Theail)ransfor e
Cancel E Forward>> Fi Cancel << Back F Finish Q

The specific parameters of the print material ([Height], [Height of the strip]) are preselected in the [Create
stripes] dialog.

The user must enter the number of terminals to be labeled [Number of terminal blocks] 6

The specific parameters are entered for the production series by selecting the [WAGO Series] @

Select WAGO Series 2000 ... 2022 for the print material.

Apply all entries by pressing the [Apply] button.

Close the dialog by clicking the [Close] button.

Streifen erstellen

ewNBOSm Serio 2000 = Hhe dos Stofens: 1100 mm (T
7 Abschiusigiate Brete dor Abschhussplstte. 0.70 o
Eincelg v Blockbrete: 2800 mm
Zele 1, Arzahi Zelen: 8 Hehe: 11.00 Klemmenbeote: 350  mm Ubemebmen |

|Anzahi Klemmen: 8
Fus Artcel 21083

Neue Streden
Blockenfugemodus: | Am Ende anhangen - Abtand 000 mmn it
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Individual Labeling
Input options for labeling text:

a) Select the marking field by double-clicking and then enter the label/caption text.
Click in the dark gray area of the window to accept the text.

b) Click [Edit Text] 0 and then click in the marking field to input text. Click in the dark gray area of the
window to accept the text.

c) Click once to select the marking field. Under the [Properties] tab, 9 enter the labeling text in the input
area [Text]. Press the enter button to accept the text.

[%f WAGO SMART SCRIPT - [Unnamed] =ne
¥ File Project Edit View Edras Window Help

Y & e 13 N [ 1 [ | @
0.9 5| ﬂ,,x. B~x0oDX9C EEGEEEES
A A A A
b o | = v T | O BB
Y Project | € Liary
4 2} C:\Users\Public\Documents\WAGO Text
(2 A themal tansfer printer Text:
{1 B. laser piinter
2 C. plotter
22 D. all round WAGD smartSCRIF
{2 E. Symbol

Properties | Symbols.

Horizontal:

Vertical:
m »

l

Text rotation: v

ine spacing: -

content: -

Figure 4.1: WAGO smartSCRIPT dialog box

Duplicate the written labels

Click once to select the marking field. Click the [Duplicate Block] Oor click on a marking field and click the
right mouse key to open the context menu.

Select [Duplicate Block] from the context menu.

=4 WAGO SMART SCRIPT - [Unnamed] = 8 X
¥ File Project Edt Vi

N O50hiMem Mo B»00x9C EEEEE?

A | matfont ~ Reguar -8 v A & W A

P

s R “?x g B | O B

2} Poject | f 1 Propetties | Symbols

4 {2} C:\Users\Public\Documents\WAGO| Text
(] A, thetmal transfer printer Text: [2
{1 B. laser pinter
23 C. plotter

(3 D. all around WAGO smartSCRIF

C3 E. Symbol 1 2 Horizontal: [Centre v

vertcal: (e )
« i y L

Textrotation: [0 -

Ine spacng: [standard v

content: | modifisble v

Figure 4.2: WAGO smartSCRIPT dialog box—Duplicate block/the selected marking field is blue

Enter the number of duplications in [Duplicate Blocks] and carry this out by clicking on [Accept].

Duplicate blocks = 1 2
Accept
—_ —) 1 ,
Block insertion mode: [Append to end ']
1 2
Figure 4.3: Duplicate Blocks dialog box 1 2

Figure 4.4: Duplications result - 3 additional
lines with identical text
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Automatic Numbering
Automatic input option for alphanumeric labeling
Click [Paginate] o on the toolbar.

Ef[WAGOSMARTSCRlPT-[Unnamed] - o8] X
i¥ File Project Edit View BExdras Window Help

Dok Me=Nog )l »0DX?CIEEAEEEHD
: 1 e

® | |4 &R A

B R = 8 R T B

The [From:] [To:] numbering range is entered under the [Definition] tab in the [Automatic Numbering] dialog
box. As shown in Figure 4.5 [From:] 1 [To:] 6.

Additional options for configuring text are available under this tab.

Place a checkmark on the [Options] tab in the [Automatic Numbering] dialog box [If necessary, append new
page] (Figure 4.6) The number of label fields required for your input is automatically added.

Automatic numbering = Automatic numbering [
Definition | Options | Definition | Options _
Settings for numbering Preview
Frome |1 1 | Append new page if necessary [W]
To: & g
Numbering mode: [Il-c-nal—v] ;
Steplength: 1 o  Stendad T
Prefix:
Suffix:
Repeat entry: 1
Repeat numbering: 1
Interval text:
Intervat 1 R
Ve i
Figure 4.5: "Automatic Numbering" dialog box Figure 4.6: "Automatic Numbering" dialog box
"Definition" tab "Options" tab
TIP

Click [Adapt to Window] Q on the toolbar in order to display all marking fields at their maximum size in the
viewing window.

@ WAGO SMART SCRIPT - [Unnamed] =B P9

{# File Project Edit View Extras Window Help

D5 50k0 e R -J.fo@ajxi-@@\g EEEEES
\ | - X &
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Importing Markings
WAGO smartSCRIPT supports importing *.xls, *.xlsx, *.txt, *.csv and *.dat files.
Click [Import...] on the toolbar.

ijGOSMARTSCNPT [Unnamed] - = @ %)
L Project Vie W
@ mw-[]«/‘ B ~0DX9CEEEEER S
* & &
D'D\:m@ 90 g

Click on [...] in the [Data Import] dialog box Figure 4.7. Select the file you want to import from the file
directory and open it with the [Open] button. The file is opened in the display area of the dialog box.
Options for selecting cells:

&= Data import

e e e ™ —_— Cells that follow each other one after another from
S ;KJ column 1lor2

= S Same cell area for columns 1 and 2

e e Sequential cells in columns 1 and 2

- i

e an — Select cells by clicking on them or dragging the mouse.

Click [Accept] to transfer the contents of the cells to the
Figure 4.7: "Data Import" — Highlighted cells 6, 7, 8 labels.
and 9 in column 2 Close the [Data Import] dialog box.

The contents of the selected cells from the import file have been transferred to the marking fields
Figure 4.8).

£ WAGO SMART SCRIPT - (Unnamed] =T
 Fle Project Edt View Etras Window Help — = =

125kl Mesm» Mot BAoDXHCEEEAIEER 4
A A+ A &
PR Rexk[ZR| Ve

) Project | ) Libvay = || Propetie: | Symbols
4 {2 ©\sers\Publc\Documents\WAGO, Text
3 A therml vanster perter

£ 8 toser
0 C plotter
(22 0. 3l around WAGO smartSCRIF

I E Symbol Horzontat
verncal
Textrot

3 L

Figure 4.8: The contents of selected cells 6, 7, 8 and 9 from column 2 are transferred to 4 labels.
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5. Print
Start the print job using WAGO smartSCRIPT.
Click [Print] on the toolbar.

_:_!fWAGOSMARTSCRlPT-[UnnuM] - o @ xR
[ File Project Edit View Bxras Window Help X
L&J»a«-; [E« B~ DX|2C|IEEQREEEHY
* A &

Dynm‘@ ;@r%‘%ﬁ"ﬂcﬂ
Use the [Print] dialog box to indicate the number of copies to be printed.
Accept the other settings displayed in the [Print] dialog box.
Start the print job by clicking on [OK].
Drucken v X4

Drucker

Nasoe: (WABO smatPreies =7

Status Beser

Twp WAGD smartPrntes

Standon USB001

Komenentat Ausgabe n Dater

Setenbereich Examplate

Ale Anzshl 1

Schider

| Rahmen diucken (h) Nur markoerte

V' Rahmen drucken (v) TruaType emubsten

¥ Inhak dacken

Ausgabeenstedungen

Sichdcke: 040 mm Versatz 000 mon
Konekhurfakior: 1.000
Ok | [ Abbechen
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6. Correcting Print Quality, Tracking Position and Cutting Option

WAGO Printer Settings software allows you to correct the printing quality of the labeling text afterwards.
If the cutter is used to cut the print material, activate the [Cutter active] option in the selection window.
Note:

The [Cutter active] and [Overrun (mm)] options are only available to you for print materials that are
approved for cutting with the cutter.

The procedure described in this chapter is representative of all print materials.

Description of defects:
a) The labeling text is not printed vertically centered.
The labeling text is moved up or down (Fig.1).
b) The labeling text is not printed centered horizontally.
The labeling text is moved to the right or left (Fig 2).
c) The labeling text is faint or has not been completely printed (Fig 3).

1 2
1 2
3 4 3 {
3 4
Fig. 1: Moved vertically Fig. 2: Moved horizontally Fig. 3: Print-out faint and

incomplete

Start the WAGO Printer Settings:

Select directory o
Select print material Q
Select gear icon 9 for print material.

Correction option by changing values:

a) [Vertical(mm)] Increase value Labeling text will be moved upward.

[Vertical(mm)] Decrease value Labeling text will be moved downward.

b) [Horizontal(mm)] Increase value Labeling text will be moved to the left.

[Horizontal(mm)] Decreased value Labeling text will be moved to the right.

c) [Heat] Increase value =  Labeling text will become darker.
Notice! A value >14 might damage the color ribbon.
[Heat] Decreased value =  Labeling text gets lighter.

d) [Cutter active] =  Not selected (Fig. 4)

The value entered in [Overrun (mm)] defines the feed path of
the print material after marking.

e) [Cutter active] =  Selected (Fig. 5)
The value entered in [Overrun (mm)] defines the feed path of
the print material to the knife position of the cutter.
Notice: Increase or decrease the overrun value stepwise in
one tenth (1/10) increments. The overrun value may not
exceed 38 mm!
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- PR -
Change Offsets/Heat Reset Settings Own Labels Options - e 4 & =m
Change Offsets/Heat Reset Settings Own Labels Options
Installed printers Selected printer
D Installed printess: Selected printer
V' WAGO smartPrinter
h
eat 12 heat 12
herizontal (s i
orizontal (mm) 75 horizantal (mm) 75
vertical (mm
(mm) 0 wvertical (mm) 0
Trail (mm)
il (¢ ER) Trail (mm) 5
%, Marking Strip Cutter, active
TR %, Marking Strip Cutter, active v
Close Save %, WMB Inline
B Labels Close Save
s Labels
Label
Label
Type signs
Type signs
5 210-801 . 5 210-802 -
A% Label 33x70 mm (white) e ¥ Label 3370 mm (silver) 5 210-801 3 210-802
<A Label 33370 mm (white) W "% Label 33470 mm (sitver) w
3 210- o 3 210-804 m
*% Label 44:99 mm (white) L * Label 44x99 mm (silver) e 5 20 o 3 210-804 o
Label 44:99 mm (white) £ Label 44x99 mm (silver) W
5 210-812
** Label 2550 mm silver w 3 210812 .
< Label 2550 mm silver s

Changing the values [Save] then [Close].

Now perform several test printouts.
The printer needs the test printouts to adjust and implement the correction values.

Note:
You can also use the auto calibration button on your smartPRINTER to start the calibration of the print

material.
Further information on this topic can be found in the smartPRINTER operating manual.
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